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Chart Terminology

Charts provide a graphical representation of data. Values or data points are displayed in formats such as: 
bars, lines, markers, filled areas, bubbles, or pie slices. These data points are grouped into series that are
identified with unique colors or patterns. In many chart types, one data point from each series is grouped 
together by category along an axis. Charts can also have titles, backdrops, legends, plots, and footnotes.  

The following illustration identifies the elements in a typical 2D chart.

The following illustration identifies the elements in a typical 3D chart.





Selecting Chart Elements

You can click the left mouse button once on a chart element to select it. The following table provides 
information about selecting each chart element.

To select... Click... Effect

Chart In the chart, but not on a specific
chart element.

Selection handles appear around the 
chart. 

Chart title Anywhere in the title area. Selection handles appear around the 
title. You can resize or reposition it.

Footnote Anywhere in the footnote area. Selection handles appear around the 
footnote. You can resize or reposition it.

Legend In the legend, but not the legend 
keys.

Selection handles appear around the 
legend. You can resize or reposition it.

Series On an element in an unselected 
series, or on the legend key 
identifying the series.

Selection handles appear on all 
elements of chart series. Handle also 
appears on legend key.

Series Label Anywhere in the series label. Selection handles appear around the 
label. You can reposition it.

Plot In the plot, but not on a specific 
chart element.

Selection handles appear around the 
chart plot. You can resize or reposition it.

Axis On the axis text, axis line, or axis
ticks.

Selection handles appear on the axis. 
You cannot manually resize the axis.

Axis title Anywhere in the axis title area. Selection handles appear around the 
axis title. 

Chart grid On any grid line. Selection handles appear around the 
grid. 

2D wall and 3D wall
or base

Any part of the base or wall other
than a grid line.

Selection handles appear around the 
wall in a 2D chart, and the base and wall
in a 3D chart. 

Data point Click on a data point in a 
selected series, or on a data 
point in the same series as 
another selected data point. 

Selection handles appear on the single 
data point only.

Data point label Anywhere in the data point label. Selection handles appear around the 
data point label. You can reposition it.

Formatting Chart Elements



You can format any element of a First Impression chart by changing settings in a dialog box. First 
Impression dialog boxes can be displayed by making a selection from a menu or by double clicking the 
appropriate chart element.



First Impression Floating Menu

Click the right mouse button anywhere within a First Impression chart to display the floating menu. Once 
the menu appears, use the left mouse button to select a menu item. Clicking on menu items followed by 
three periods displays a submenu.

The following table describes the purpose of each item on the floating menu.

Item Dialog Box Displayed Purpose

General Format Chart Formats the fill, frame, and shadow displayed 
in the chart backdrop and provides a 
convenient place to toggle on and off the 
display of the title, the legend, the footnote or 
the 2nd Y axis.

Plot Format Plot Changes the chart type, stacks or unstacks 
chart series, turns lines and markers on or off,
controls the location of the plot, formats the 
plot backdrop, reorders series, sets chart-type
specific options, and controls 3D chart 
formatting and lighting.

Series/Series Format Series Controls the display of series, plots a series 
on a secondary axis, formats series 
appearance such as bar shape, line style, 
markers, and fill colors, sets series smoothing,
and formats statistics lines and guidelines.

Series/Label Format Series Label Controls the series label location and line 
style, edits the label text, formats the label text
and position, and formats the label backdrop.

Series/Data Point Format Data Point Formats the fill and marker for an individual 
data point.

Series/Data Point 
Label

Format Data Point 
Label

Controls the type and location of the label on 
an individual data point, formats the font and 
layout of the label text, and formats the label 
backdrop.

Axis/Axis Format Axis Formats the width and color of the axis, axis 
grid, and axis ticks, and changes axis scale.

Axis/Label Format Axis Label Formats the axis label backdrop and font, and
controls the positioning and alignment of the 
axis labels.

Axis/Title Format Axis Title Formats the axis title backdrop and font, edits 
the axis title text, and controls the display of 
the axis title and its location.



Legend Format Legend Formats the legend backdrop, changes the 
font used to display the legend text, and 
controls the legend location.

Title Format Title Formats the title backdrop and font, edits the 
title text, and controls the display of the title 
and the its location.

Footnote Format Footnote Formats the footnote backdrop and font, edits 
the footnote text, controls the display of the 
footnote and the its location.

Copy None Places a copy of the current chart on the 
clipboard in Windows Metafile (.wmf) format.

Paste None Takes a graphic in Windows Bitmap (.bmp) or 
Windows Metafile (.wmf) format from the 
clipboard and places it in the selected 
elements backdrop or fill.

Print Print Displays the Print dialog box.

Save As Save As Saves the current file as a chart file (.vtc), a 
bitmap (.bmp), or a metafile (.wmf)

Load Load Chart Loads an existing chart file into the current 
chart control. The chart you load replaces the 
chart already in the control.

If you use the menu to display the Format Axis, Format Axis Title, Format Axis Label, Format Series, 
Format Series Label, Format Data Point, or Format Data Point Label dialog boxes, you are prompted to 
identify the specific axis, series, or data point you want to modify.



Double Clicking on Chart Elements

You can also display First Impression dialog boxes by double clicking chart elements. The following table 
lists the dialog box displayed when you double click various chart elements.

To format... Double-click... Dialog Box Tab

Chart Backdrop The chart but not on a specific 
chart element.

Format Chart Backdrop

Footnote Any part of the footnote Format Footnote Text

Title Any part of the title Format Title Text

Legend Backdrop Anywhere in the legend area other
than the text or keys.

Format Legend Backdrop

Legend Text The legend text. Format Legend Font

Plot Anywhere in the plot area, but not 
on a specific chart element.

Format Plot Type

Axis Label An axis label. Format Axis Label Font

Axis Line or Ticks The line or ticks on an axis. Format Axis Scale

Axis Title The axis title text. Format Axis Title Text

Grid Any grid line. Format Axis Grid

3D Base or Wall Anywhere on the base or wall 
other than a grid line.

Format Plot Base & Walls

Series A chart element in an unselected 
series or the legend key identifying
the series.

Format Series Line for line type series 

Fill for all others

Data Point A selected data point, or a point in 
the same series as a selected data
point.

Format Data Point Options or Fill if series 
defaults have been 
overridden.

Series Label The series label. Format Series Label Options or Text if series 
defaults have been 
overridden.

Data Point Label The data point label. Format Data Point Label Options or Text if series 
defaults have been 
overridden

Using Dialog Boxes



Most First Impression dialog boxes provide sets of options grouped on separate tabs. As you click each 
tab, the controls in the dialog box change to allow you to edit a different set of options. Any options that 
are not appropriate for the current chart type or situation are grayed. 
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Chart Data Grid

Each chart is associated with a data grid. This data grid is a table that holds the data being charted. The 
data grid can also include labels used to identify series and categories on the chart. The person who 
designs your chart application fills the data grid with information by inserting data, or by importing data 
from a spreadsheet or array. 

The following illustration shows the relationship between a data grid and a chart.

In most cases, each column in the data grid translates to one series on the chart. However, First 
Impression supports a number of chart types that require two or more columns of data to chart a series. 
These chart types include XY, polar, bubble, hi-lo, and gantt charts. 

Note    You may be formatting a chart in an application designed for you by someone else. To use one of 
the chart types that requires more than one column of data for a series, you may need to have the chart 
designer familiarize you with the structure of the chart data. 



Chart Types

Click on the chart name in the following list general usage information about each chart type.

Area Charts Bar Charts

Horizontal Bar Charts Clustered Bar Charts

Line Charts Step Charts

Combination Charts Pie and Doughnut Charts

Radar Charts XY Charts

Polar Charts Bubble Charts

Hi-Lo Charts Gantt Charts

Area Charts

Use area charts to emphasize the relative importance of values over a period of time. An area chart 
focuses on the magnitude of change rather than the rate of change. Each filled-area on the chart 
represents a series and is identified by a different color or pattern. Values are plotted on the vertical (Y) 
axis and categories are plotted on the horizontal (X) axis. You can also chart one or more series against 
the secondary Y axis instead of the primary axis.



Bar Charts

Use bar charts to compare one item to another, or to compare a number of items over a period of time. 
These charts are particularly effective at showing large changes from one category to another. Each 2D 
or 3D bar represents a value in the data grid. Bars representing a series are located at the same position 
in each category and have the same color and pattern.

In 2D charts, values are grouped on the vertical (Y) axis, and bars are grouped by category along the 
horizontal (X) axis. On 3D charts, values are plotted on the vertical (Y) axis, categories are grouped along
the horizontal (X) axis, and the depth (Z) axis shows series.



Horizontal Bar Charts

Horizontal bars are similar to standard bar charts except that the categories are organized on a vertical 
(X) axis and the values are plotted on a horizontal (Y) axis. 



Clustered Bar Charts

Series and data points in a clustered bar chart are displayed as they are in a 2D bar chart, however the 
chart and all the chart elements are displayed in 3D.



Line Charts

Use line charts to show trends or changes in data over a period of time. These charts emphasize time 
flow and rate of change rather than amount of change. 

In 2D line charts, values are plotted along the vertical (Y) axis and categories are displayed on the 
horizontal (X) axis. In 3D charts, values are plotted on the vertical (Y) axis, categories are grouped along 
the horizontal (X) axis, and the depth (Z) axis shows series. 



Step Charts

Use step charts to compare items that do not show trends. Step charts display distinct points along the 
value (Y) axis, with vertical lines showing the difference between each point. The horizontal (X) axis 
shows categories. 



Combination Charts

Use combination charts to visually highlight the differences between multiple series of data. A different 
method can be used to draw each data series.    



Pie and Doughnut Charts

Use pie or doughnut charts to show the relationship of parts to the whole. Each pie or doughnut 
represents a category. Each slice of the pie or doughnut represents a value in that category. You can 
separate or explode slices in a chart by clicking a slice and dragging it away from the rest of the pie or 
doughnut. 



Radar Charts

Use radar charts to show changes or frequencies of each series relative to a center point and to one 
another. Lines connect all the data markers in the same series. You can choose to fill the lines, thereby 
creating a radar area chart. 



XY Charts

Use XY charts to plot two groups of numbers as one series of XY coordinates. Each series on the chart 
requires two columns of data in the data grid. The first column holds the X coordinate and the second 
column the Y coordinate. The column label on the first column in each series is used to identify the series 
in the legend. Additionally, any formatting applied to the first column is used to display the series on the 
chart. Any formatting applied to the second column is ignored. You can use markers or lines or both to 
draw the XY points. 



Polar Charts

Use polar charts to show cyclical trends. The polar chart requires two columns in the data grid for each 
chart series: the first column holds the distance from the center of the chart (the radius), and the second 
column contains the angle on the perimeter of the chart. The column label on the first column in each 
series identifies the series in the legend. Additionally, any formatting applied to the first column is used to 
display the series on the chart. Any formatting applied to the second column is ignored. 



Bubble Charts

Use bubble charts to show a visual comparison using three coordinates. Each bubble requires three 
columns of data in the data grid. The first column holds the X coordinate, the second the Y coordinate, 
and the third the bubble size. All the coordinates in a bubble chart measure values; therefore, the vertical 
(Y) axis and the horizontal (X) axis both show values. The column label on the first column in each series 
identifies the series in the legend. Additionally, any formatting applied to the first column is used to display
the series on the chart. Any formatting applied to the second and third columns is ignored. 



Hi-Lo Charts

Hi-lo charts are most commonly used to show stock market information. However, these chart types can 
also be used for scientific data such as indicating changes in readings over a period of time. The vertical 
(Y) axis shows values and the horizontal (X) axis shows categories or dates.

First Impression supports a number of variations to the hi-lo charts. These include: hi-lo-close with the 
close marker crossing the data point or extending to the right of the data point, open-hi-lo-close, and 
open-hi-lo-close bar.

The data in the data grid must be organized appropriately for each variation of the hi-lo chart.

A hi-lo chart requires two columns for each data series: the first column is used for the high point 
and the second is used for the low point.

A hi-lo-close chart requires three columns for each data series: the first column is used for the 
high point, the second for the low point, and the third for the closing point.

An open-hi-lo-close or a open-hi-lo-close bar chart (sometimes called candle stick charts) 
requires four columns of data for each data series: the first column is used for the open point, the second 
for the high point, the third for the low point, and the fourth for the closing point.

The column label on the first column in each series identifies the series in the legend. Additionally, any 
formatting applied to the first column is used to display the series on the chart. Any formatting applied to 
the remaining columns that make up the series are ignored.



Gantt Charts

Use gantt charts to display a range of bars that indicate the relative time required for various activities 
within a project. The horizontal axis (Y) shows dates and the vertical axis (x) shows categories. This chart
type requires two columns of data for each series. The first column holds the start date, and the second 
column holds the duration. 
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Changing the Chart Type
Format Plot Dialog Box

To change the chart type:

1. Double click the chart plot; or, use the right mouse button to display the floating menu and select 
Plot.

The Format Plot dialog box is displayed.

2. If necessary, click the Type tab. 

3. Click the 2D or 3D button to display a list of 2D or 3D chart types in the Chart Type list box.

4. Select a chart type in the Chart Type list box.

3. When you have made all necessary changes, click OK or Apply to redraw the chart to reflect the 
new settings.



Creating Combination Charts
Changing the Chart Type Format Plot Dialog Box

If you select Combination as the chart type, you must also specify the type used to display each series in 
the chart. 

To change a series type:

1. Double click the chart plot; or, use the right mouse button to display the floating menu and select 
Plot.

The Format Plot dialog box is displayed.

2. If necessary, click the Type tab. 

3. Click the 2D or 3D button to display a list of 2D or 3D chart types in the Chart Type list box.

4. Select Combination in the Chart Type list box.

5. Select a series in the Series Names list box. 

The Series Types list now shows the valid types for the selected series.

6. Select the type you want to use for the selected series. 

You can also select All Series to set the same type for all series in the chart.

Continue specifying types for each series as necessary.    



Radar Charts 
Format Plot Dialog Box

If you select Radar as the chart type, you can specify whether each series is displayed as a line or filled 
area. 

To change the variation of a radar chart:

1. Double click the chart plot; or, use the right mouse button to display the floating menu and select 
Plot.

The Format Plot dialog box is displayed.

2. If necessary, click the Type tab. 

3. Select the 2D radio button to display a list of 2D chart types.

4. Select Radar in the Chart Type list box.

5. Select a series in the Series Name list.

6. Select a type for the series in the Series Type list.

Continue selecting types for additional series as necessary.



Hi-Lo Charts
See Also Format Plot Dialog Box

When you select Hi-Lo as the chart type, you can specify the variation of hi-lo chart you want to display as
well as assign different types to other series.

To specify a Hi-Lo-Close chart with Volume information:

1. Double click the chart plot; or, use the right mouse button to display the floating menu and select Plot.

The Format Plot dialog box is displayed.

2. If necessary, click the Type tab. 

3. Select the 2D radio button to display a list of 2D chart types.

4. Select Hi-Lo in the Chart Type list.

5. If a column in the data grid holds dates, select that series name and then select the Dates series type.

This instructs First Impression to use the values in this column to create a date axis for this chart. The 
series is automatically excluded so that it is not actually charted. 

6. Select the first series that holds stock information in Series Names list.

7. Select one of the Hi-Lo-Close variations in the Series Type list box.

The second and third column in every series are indented to show that the series requires three columns 
of data to chart a Hi-Lo-Close chart. 

8. Select the series that contains volume information in the Series Name list box.

9. Select the series type you want to use to display volume data. 

Bar, Line, or Area would be typical choices for displaying volume data. 

10. Click OK or Apply to redraw the chart.

Since volume information is usually very different from the high, low, and close price of stock you may 
need to take the following steps to finish the chart.

11. Double-click the Volume series in the chart; or, use the right mouse button to display the floating 
menu and select Series/Series to display the Format Series dialog box.

If you use the menu, you must specify which series you want to format.

12. If necessary, click the Options tab.

13. Check the Plot on 2nd Y Axis check box. 

14. Click OK.





See Also

Date Axis Scaling

Format Series Dialog Box



Reordering Series
Format Plot Dialog Box

You can change the order in which the series in a chart are displayed. This can be particularly useful if 
one series obscures the view of the data in another series. By rearranging the series, you can find the 
most aesthetically pleasing way to present your data. 

To reorder the series in a chart:

1. Double-click the chart plot; or, use the right mouse button to display the floating menu and select Plot.

2. Click the Order tab.

3. Select a series in the Series Order list box.

4. Click Up to move the series up in the drawing order. Click Down to move the series down in the 
drawing order. 

5. Click OK or Apply to redraw the chart.

You can also use buttons on the Order tab to stack and unstack series and to change the order of stacked
series. 

To stack series in the Order tab:

1. Select the last series in the Series Order list box.

2. Click Stack.

The series you highlighted is shown as stacked with the preceding series.

3. Click Stack again.

The two stacked columns are now stacked with the preceding series. The order in which they appear in 
the stacked list is the order in which they are drawn, first series on the bottom of the stack. 

4. Click Apply to redraw the chart.

5. To unstack the series, select the Stack associated with the series in the Series Order list and click 
Unstack.



Adding Chart Elements

In addition to the plot, the major chart elements are titles, legends, and footnotes. The following 
information explains how to add these elements to a chart.

To add a title to a chart:

1. Use the right mouse button to display the floating menu.

2. Select Title to display the Format Title dialog box.

3. Check the Visible check box to display the title.

4. Select the Text tab.

5. Type the title text in the Text field.

6. Click OK or Apply to redraw the chart to include the new title.

To add a legend to a chart:

1. Use the right mouse button to display the floating menu.

2. Select Legend to display the Format Legend dialog box.

3. Check the Visible check box to display the legend. 

By default, series labels are used to identify each series in the legend.

4. Click OK or Apply to redraw the chart to include the legend.

To add a footnote to a chart:

1. Use the right mouse button to display the floating menu.

2. Select Footnote to display the Format Footnote dialog box.

3. Check the Visible check box to display the footnote.

4. Select the Text tab.

5. Type the footnote text in the Text field.

6. Click OK or Apply to redraw the chart to include the new footnote. 



Optimizing Text Display

You can optimize the display of text on a chart. First Impression offers two modes for displaying text. One 
mode optimizes the appearance of text on the screen, and the other mode optimizes text for printed 
output.

To optimize text:

1. Use the right mouse button to display the floating menu.

2. Select General from the floating menu.

3. Select the Options Tab.

4. In the Text Metrics section of the dialog box, select one of the following radio buttons.

Printing. Choose this radio button to use TrueType virtual font metrics to layout text so that text is laid out
exactly where it is printed.    TrueType virtual font metics are not very accurate for text displayed on the 
screen. Text display on the screen may be a larger or smaller than the virtual metrics predicted.    Larger 
text may not fit where it is suppose to and part of a character, a whole character, or even in some cases 
words may be clipped.

Screen Display. Choose this radio button to layout the text for the screen instead of using the virtual font 
metrics.    Charts layouted out this way do not print exactly as they appear on the screen but the text is not
clipped on the screen.    The printed text is generally a bit smaller and so the text may appear in slightly 
different places.

5. Click Ok to redraw the chart.



Controlling the Display of Chart Elements
Format Chart Dialog Box

First Impression provides a quick and easy way to turn off or on the display of existing chart elements 
such as the title, the legend, the footnote, and the second Y axis. 

To hide or show a title, footnote, legend, or second Y axis:

1. Click the right mouse button to display the floating menu.

2. Select General to display the Format Chart dialog box with the Options tab selected.

3. Check the Show Title, Show Footnote, Show Legend, or Show 2nd Y Axis check box to display any of
those elements. Uncheck those items to hide any of those elements.

Note     If you have not created a title or footnote, checking the Show Title or Show Footnote check box 
displays default text.

4. Click OK or Apply to redraw the chart.



Automatic Chart Layout
Location Tab Positioning Chart Elements

By default, First Impression operates in automatic layout mode. As you add elements such as a title or 
legend to a chart, the existing chart elements are resized and repositioned to make room for the new 
elements. 

In automatic layout, the chart plot, title, legend, and footnote are all drawn within their individual areas of 
the chart. The size of text used for the title, legend, footnote, and the axis labels and titles determines the 
size of each area. If you use very large fonts or long text, elements may be cropped and the axis labels 
and titles may be dropped from the plot. 



Positioning Chart Elements
Custom Chart Element Positions Automatic Chart Layout

By default, when you add a title, legend, or footnote, First Impression puts the object in a specific location.

First Impression has nine preset locations for placing these objects. These positions are identified in the 
following illustration.

To move a chart element to a new predefined position:

1. Double click an element to display the appropriate dialog box.

2. Select the Location tab.

3. Select one of the position radio buttons and click OK or Apply.



Custom Chart Element Positions
Positioning Chart Elements Location Tab

You can override the size and layout of chart elements by selecting and dragging elements on the screen 
or by making settings in a dialog box. When you manually reposition an element, it is no longer in 
automatic layout mode. First Impression no longer considers the element when allocating space for the 
remaining chart elements that use automatic layout.

To resize or reposition objects manually:

1. Select the title, footnote, plot, or legend.

2. Once the object is surrounded by selection handles you can drag it to a new location or resize it 
as desired.

Bear in mind that what you are actually resizing is not the text or plot itself, but the bounding rectangle 
around the object. Based on the size you make the object, First Impression may have to resize or clip 
objects to fit the space.

To resize or reposition objects using dialog box settings:

1. Double click the title, footnote, plot, or legend.

The appropriate dialog box is displayed.

2. Select the Location tab.

3. Select the Custom radio button.

4. Enter values in the Top, Left, Height, and Width fields to describe the coordinates of the upper left
corner of the object and its height and width.

First Impression uses the measurement unit specified in your Windows default settings. 



Formatting Text
Text Tab

Similar methods are used to format most of the text on a chart. This section discusses the formatting of 
fonts used to display all chart text as well as the orientation and alignment of chart titles, footnotes, legend
text, and axis titles.



Formatting Fonts
Font Tab Formatting Text

You can specify the font, font style, font size, font color, and special effects used to display a text element 
on a chart.

To format text:

1. Double-click the left mouse button on the text you want to format. 

You can also use the right mouse button to display the floating menu and select the appropriate item for 
the chart element you are formatting. 

The appropriate dialog box is displayed with the Font or Backdrop tab selected. 

2. Select the Font tab.

The dialog box tabs used to format fonts for the chart titles, legends, footnotes, and axis titles are all the 
same. 



Aligning and Orienting Text
Text Tab

You can also control the justification, orientation, and alignment of chart text. The horizontal and vertical 
alignment of text is only observed if you enlarge the rectangle holding the text. 



Editing Backdrops 
Backdrop Tab

You can enhance a charts appearance by placing a backdrop on the chart itself, and on individual chart 
elements. A backdrop can include a frame or box around the chart or chart element, a shadow behind the 
element, and a pattern, gradient, or graphic picture behind the element.

The following illustration shows the various chart elements that can be assigned a backdrop.

To edit a backdrop:

1. Double click the left mouse button on the chart element whose backdrop you want to edit. 

You can also use the right mouse button to display the floating menu and select the appropriate command
for the chart element you are formatting.

2. Once the appropriate dialog box is displayed, select the Backdrop tab if necessary. 

The dialog box tabs used to format the backdrops for the chart control, chart plot, title, legend, labels, 
series labels, data point labels, and footnotes are all the same. 

3. When you have finished making any necessary changes to the backdrop, click OK or Apply to 
redraw the chart to reflect the changes.



Resetting To Default Formats
Format Chart Options Tab

You can reset a chart to the First Impression default formats. All chart options, except the chart type are 
returned to their default values.

To reset the chart:

1. Click the right mouse button to display the floating menu.

2. Select General to display the Format Chart dialog box with the Options tab selected.

3. Click the Reset button.

4. Click OK or Apply to redraw the chart.
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Format Chart Dialog Box

This dialog allows you to turn on or off the display of some common chart elements, reset any chart 
formatting to its default values, and specify a backdrop for the entire chart. 

For information about the options on a specific tab of the Format Chart dialog box, select the tab name 
from the following list.

Options

Backdrop



Format Chart Options Tab

Options on this tab control the display of the title, footnote, legend and second Y axis on the current chart.
This tab also gives you a means to reset the chart to its default display settings.

Show Title. Check this box to display a title on the chart. Uncheck this box to hide the title
Show Footnote. Check this box to display a footnote on the chart. Uncheck this box to hide the 

footnote.
Note      If you have not defined a title or footnote for a chart default text is displayed when you check 
these boxes.

Show Legend. Check this box to display a 
legend on the chart. Uncheck this box to hide the footnote.

Show 2nd Y Axis. Check this box to display a 
second Y axis on the chart. Uncheck this box to hide the second axis.

Reset. Click this button to discard any formatting
you have applied to the chart except for a change in chart type. All other formats are reset to their default 



values.

You can optimize the display of text on a chart. First Impression offers two modes for displaying text. One 
mode optimizes the appearance of text on the screen, and the other mode optimizes text for printed 
output.

Text Metrics. Select one of the following radio buttons to determine how text on a chart is optimized.

Printing. Choose this radio button to use 
TrueType virtual font metrics to layout text so that text is laid out exactly where it is printed.    TrueType 
virtual font metics are not very accurate for text displayed on the screen. Text display on the screen may 
be a larger or smaller than the virtual metrics predicted.    Larger text may not fit where it is suppose to 
and part of a character, a whole character, or even in some cases words may be clipped.

Screen Display. Choose this radio button to 
layout the text for the screen instead of using the virtual font metrics.    Charts layouted out this way do not
print exactly as they appear on the screen but the text is not clipped on the screen.    The printed text is 
generally a bit smaller and so the text may appear in slightly different places.



Format Plot Dialog Box 

The options in this dialog box control the location and appearance of the chart plot, formatting of 3D 
charts and formatting and ordering that affects all series or data points in the chart.

For information about the options on a specific tab of the Format Plot dialog box, select the tab name from
the following list.

Type Location

Backdrop Order

Options 3D View

3D Lighting Base and Walls

Format Plot Type Tab

The options grouped in the Chart section of    this tab control the chart type and whether the chart is 
stacked.

Chart Radio Buttons. Select the 2D radio 
button to display a list of the 2D chart types in the Chart Type list box. Select the 3D radio button to 
display the 3D chart types.

Chart Type List Box. Select a type from the list.



Stacked Check Box. Click this box to stack all 
the series of the current chart. 

You can stack series in a bar, line, area, step, combination, clustered bar, horizontal bar, and gantt chart. 
Stacking places the data points from the same category on top of each other. Each bar still represents the
same value. 

Stacking data shows how all categories in a series compare over time, or compares each part to the total.

% Axis Check Box. Check this check box to 
add together all the values in each category. That value is considered 100 percent. Then each data point 
in the category is drawn as a percentage of that sum. 

Options in the Series section of this tab control the type used to display each series and whether lines or 
markers are displayed on the series.

Series Name List Box. All series in the current 
chart are listed in this list box. If the current chart is a type that requires more than one column of data in 



the data grid to chart a series, one or more series may be indented in the dialog box.

Series Type List Box. The valid series types for
the current chart type are listed here. 

Lines or Markers Check Boxes. These check 
boxes are enabled if    the current chart type is a 3D chart or a 2D    chart type other than pie or bubble. 
Markers can represent the data points on the chart for all 2D types other than bubble and pie charts. 
Markers and lines can both represent all data points on 2D line, XY, Radar, and Polar charts. 

To display lines, select the Lines check box.

To display markers, select the Markers check box.

To display both markers and lines, select both check boxes.



Location Tab
See Also

A number of dialog boxes contain the Location Tab. Options on this tab control the display and position of 
the footnote, legend, plot or title of the chart.

Visible check box. Check this box to display 
the chart element. Uncheck this box to hide the chart element.

Top Left, Top, Top Right, Right, Bottom 
Right, Bottom, Bottom Left, and Left radio buttons. Select one of these buttons to place the chart 
element in one of the predefined positions 

Custom radio button. Select this radio button 
to enable the four positioning fields below the custom radio button. Enter values in points in the Top, Left, 
Height, and Width fields to describe the coordinates of the upper left corner of the object and its height 
and width.





See Also

Format Footnote Dialog Box

Format Legend Dialog Box

Format Plot Dialog Box

Format Title Dialog Box

Positioning Chart Elements

Custom Chart Element Positions



Backdrop Tab
See Also

A number of dialog boxes contain a Backdrop Tab. The options on this tab control the appearance of the 
fill, frame and shadow around elements such as the chart itself, the chart plot, title, footnote, legend, 
series label, data point label, and axis labels.

Backdrop Fills

The controls in the Fill section of the dialog box allow you to set the fill type, color, and pattern.

No Fill. The chart control or chart elements have
no fill, so any formatting applied to the surface behind them shows through. A picture can still be applied 
to a element with no fill.

Pattern. One or two colors are used to display a
pattern in the chart control or chart element. 



Pattern Picker. Click the control to display the 
pattern picker. Click one of the patterns, click None to have no fill on the object, or Solid to use only the fill
color to fill the object. 

Patterns are bitmaps. A low resolution version of each bitmap displays the pattern on the screen. When 
you print a chart, a high resolution version of the bitmap is used if the output device prints at more than 
144 dpi. The higher the resolution of the output device, the smaller the copies of the bitmaps that make up
the patterns are reproduced. At high resolutions, First Impression adjusts the patterns to prevent the lines 
from getting too close together. Hatches are not bitmaps, but actual lines drawn to fill the object. They 
always appear the same regardless of the output resolution. Hatches can be used to output First 
Impression charts on a plotter.    The last row of patterns in the pattern picker are hatch patterns.

Gradient. A gradient blends two colors to create 
the fill. The colors can be blended from top to bottom, left to right, in concentric rectangles, or concentric 
ovals. 

Gradient Picker. Select a gradient type from the
popup menu. 



Fill/From Color and Pattern/To Color. Click the
control to display the color picker. Choose a predefined color or click Custom to create your own color. 

The fill color is used to create a solid pattern. For a pattern fill, the pattern color is drawn on top of the fill 
color. 

For a gradient fill, use the Fill/From Color popup to specify the color used as the top color in a horizontal 
gradient, the left color in a vertical gradient, and the center color in a rectangle or oval gradient. Use the 
Pattern/To Color popup to specify the color used as the bottom color in a horizontal gradient, the right 
color in a vertical gradient, and the outer color in a rectangle or oval gradient.

Picture Fills 

The controls in the Picture section of the dialog box allow you to specify a graphic image to use as the 
picture fill, preview the picture, select a method for fitting the picture into the background, and specify 
whether the graphic is saved with the chart. You can use a picture fill on an element regardless of its 
pattern or gradient setting. If the graphic does not cover the entire backdrop area, any specified pattern or
gradient covers the remaining area. 

Picture. This control displays a preview of the 
graphic. When you enter a valid path and file name into the File text box, or paste a graphic from the 
clipboard, the picture is previewed in the Picture control. Only the Windows Bitmap (.bmp) and Windows 
Metafiles (.wmf) graphic formats are supported.
Note     If you use a Windows metafile for the graphic, it does not show up if you use the copy command 
to copy the chart to the clipboard. Windows limits you from having a metafile that contains a metafile. If 
you plan to copy the chart to the clipboard, use a bitmap for the graphic instead of a metafile.



Fit Method. You can also choose how to fit the 
graphic into the backdrop space. The following table lists the options for fitting graphics.
Constant Description

Actual Size Displays the graphic at the original size it was created. If the original size of the graphic
is too large to display in the backdrop, the graphic is cropped. If the original size of the 
graphic is too small to fill the backdrop, it is centered in the backdrop.

Best Fit Scales the graphic proportionally to fit entirely within the backdrop.

Stretch to Fit Scales the graphic to fit backdrop regardless of its original proportions.

Tiled Duplicates the graphic repeatedly to fill the backdrop.

Crop Fitted Centers the graphic and scales it proportionally to fill the backdrop. Any part of the 
image that falls outside the backdrop is cropped.

File. To add a picture to the backdrop, type the 
full path to the graphic file in the File field or press the Browse button to display an Open dialog box. 
When you specify a valid path, a preview of the graphic appears in the dialog box.



Embed. To save the picture file with the chart, 
select the Embed check box. In order to save space, it is better not to embed charts unless they are not 
going to be available later.

Clear. Click this button to clear an existing 
picture from the backdrop. 
Note     Some graphics files can be very large. In order to minimize performance problems on some 
systems, it is recommended that you always clear one picture from the backdrop before specifying a new 
one. This prevents the system from having to deal with two large graphics files simultaneously.

Paste. Click this button to paste a .wmf or .bmp 
file from the clipboard into the current backdrop. 



Browse. As an alternative to typing the path and
filename for the graphic file, you can click Browse to display a standard Open dialog box. Select the file to
display and click OK. The pathname and file then appear in the File field and a preview of the graphic 
appears in the Picture control.
Note      You can also paste a graphic into an existing backdrop by selecting the backdrop on the screen 
and selecting the Paste command from the floating menu. Select the graphic file you want to paste into 
the backdrop and Click OK.

Backdrop Frames

The controls in the Frame section of the dialog box allow you to create a frame and shadow for the 
current backdrop.

Style. Select a frame style from the popup. 

Width. Enter the number of points to be used as
the width for the frame lines. A point is 1/72 of an inch. For the Thick Inner and Thick Outer frames, the 
width sets the thick line. 



Color. Select a color for the frame lines from the
Color picker.

Shadow. Select this check box to place a 
shadow on the frame. The following chart shows shadows around the chart control, plot, title, legend, and 
footnote.

Shadow Offset. Specify the number of points 
the shadow is offset from the frame. You can specify negative values to offset the shadow to the left and 
top of the element instead of the bottom and right of the element.



See Also

Editing Backdrops

Format Axis Label Dialog Box

Format Axis Title Dialog Box

Format Chart Dialog Box

Format Data Point Label Dialog box

Format Footnote Dialog Box

Format Legend Dialog Box

Format Plot Dialog Box

Format Series Label Dialog Box

Format Title Dialog Box 



Format Plot Order Tab
Reordering Series

The options in this tab control the order in which series are drawn on the chart and allows you to stack or 
unstack series individually.

Series Order List Box. This list displays all 
series in the current chart. Select the series you want to move or stack.

Up. Click Up to move the currently highlighted 
series up in the drawing order.

Down. Click Down to move the currently 
highlighted series down in the drawing order.



Stack. Click Stack to stack the currently 
highlighted series on top of the series that precedes it in the drawing order. The word Stack appears in 
the Series order list and the stacked series are indented.

Unstack Highlight an occurrence of the word 
Stack in the Series order list box and click Unstack to unstack the series in that stack group.



Format Plot Options Tab

The options in this tab control the appearance of the plot chart as a whole.

Controlling Bar Spacing

There are three settings that control the spacing between bars on bar and hi-lo charts. The Bar Gap Ratio
applies only to 2D bar charts, the Z Gap Ratio applies only to 3D charts, and the X Gap Ratio applies to 
both 2D bar and 3D bar charts. For all three of these settings, enter a value that represents the distance 
between bars as a percentage of the bar width. 

Bar Gap Ratio. The Bar Gap Ratio controls the 
distance between bars within a category. Enter any value between -100 and 10,000. The default bar gap 
of 50 percent places a space between each bar that is half as wide as the bars. 

X Gap Ratio. The X Gap Ratio controls the 
distance between individual bars on the X axis of a 3D bar chart and the space between categories of 
bars on 2D bar and hi-lo charts. Enter any value between 0 and 10,000.



Z Gap Ratio. The Z Gap Ratio controls the 
distance between series of bars on the z axis of a 3D chart. Enter any value between 0 and 10,000.

Controlling Chart Direction

The options in the Rotation section of the Options tab control how pie, doughnut, polar, and radar charts 
are drawn.

Clockwise. Check this box to draw pie, 
doughnut, polar, and radar charts in a clockwise direction. Uncheck the box to draw the charts in a 
counterclockwise direction.

Starting Angle. Enter a value between 0 and 
360 degrees to indicate the point on a circle at which drawing starts for pie, doughnut, polar, and radar 
charts. Enter 0 to indicate the 3 oclock position. A starting angle of 90 degrees moves the starting position
to 12 oclock if the direction is set to counterclockwise, or to 6 oclock if the direction is set to clockwise. 
The value is displayed in degrees, radians, or grad, depending on the setting in the Angle Units option. 



Scale Angle. Choose where you want to display
the scale on the chart. Angles are measured in the direction specified by the Clockwise check box. A 
value of 0 starts at the 3 oclock position. 

Angle Units. Choose the unit of measure for all 
angles in the chart. This affects the unit of measure used for: drawing the angle (Y coordinate) in a polar 
chart; the starting angle for polar, pie and doughnut charts; scale angle for radar and polar charts; and the
rotation and elevation of 3D charts. Choose degrees, radians, or grads.

Formatting Chart Elements

The settings in the Element section of the Options tab are settings that affect all elements of the chart. 

Sorting. This setting controls the order in which 
the slices of pie and doughnut charts are drawn. The following table lists the options for this setting.
Setting Description

None Pie slices are drawn in the order the data appears in the data grid.



Ascending Pie slices are drawn from the smallest to the largest slice, starting at the defined starting 
angle.

Descending Pie slices are drawn from the largest to the smallest slice, starting at the defined starting 
angle.

Weighting. This setting controls the size of each
pie or doughnut in relation to the other pies or doughnuts in the same chart. The following table lists the 
options for this setting.
Setting Description

None All pies and doughnuts are drawn the same size.

Pie Total The slice values in each pie are totaled and the pie with the highest total identified. The 
size of each pie in the chart is determined by the ratio of its total value compared to the 
largest pie. 

First Series The size of a pie is determined by the relationship of values in the first series of each 
pie. The larger the value in the first series, the bigger the pie. It is most common to 
exclude this first series so that the values are not drawn as pie slices.

Weighting Radio Buttons. Select the Area 
radio button to weight pies and doughnuts by the area of the chart element. Select the Diameter radio 
button to weight pies and doughnuts by the diameter of each chart element.



Thickness Ratio. This setting specifies the 
percentage of the pie or doughnut radius that determines the height of a 3D pie or doughnut. The higher 
the percentage, the taller the pie or doughnut. You can enter a value between 0 and 100 percent.

Top Radius Ratio. This setting specifies the 
percentage of the pie radius that is used to draw the top of a 3D pie. A ratio of 100 draws a cylinder; 
values less than 100 result in a tapering of the top of the pie. A value of 0 results in a cone.

Interior Ratio. This setting describes the ratio of
the entire doughnut size that is used to display the interior "hole" of the doughnut. You can enter any 
number between 1 percent and 100 percent for this setting.



Sides. This setting controls the number of sides 
used to draw a doughnut. More sides give the doughnut a rounder, smoother appearance. A doughnut 
must have at least two sides. Enter a value between 1 and 360. If you enter 1, First Impression 
determines how many sides are needed to draw a round bar at the given bar size. Entering a very large 
number may impact performance. 

Largest Bubble Ratio. This setting controls the 
appearance of bubbles in a bubble chart. It describes the percentage of the shortest chart axis that is 
used as the diameter of the largest bubble. All other values are then sized in their relationship to the 
largest bubble. Enter a value between 2 and 50.

Pie/Doughnut Label Position. This setting 
controls where the labels for each pie or doughnut are placed on the chart. These labels are actually 
category labels. They use the font and backdrops defined for the X axis labels. The following table lists 
the options for this setting.
Setting Description

None No label is displayed.



Above The label is displayed above the pie or doughnut.

Below The label is displayed below the pie or doughnut.

Center The label is centered on the pie or doughnut.



Format Plot 3D View Tab
Formatting 3D Charts

Options on this tab control the rotation, elevation, viewing distance, and projection of a 3D chart, as well 
as the height to width and depth to height ratios    used to display a chart.

Elevation. Enter a number between 0 and 90 
degrees in this control to describe the relative height from which a chart is viewed. If you set the elevation 
to 90, you look directly down on the top of the chart. If you set the elevation to 0, you look directly at the 
side of the chart. If you are using an angle measurement other than degrees, enter the proper 
equivalents. The default elevation is 30 degrees.

Rotation. Enter a number between 0 and 360 
degrees to specify the angle that the chart is turned from the viewer. If you are using an angle 
measurement other than degrees, enter the proper equivalents. Rotation does not apply to 3D pie or 
doughnut charts.



Projection. Select a projection type from the 
popup menu. 

When you look at a 3D chart on a computer screen or a printed piece of paper, you are looking at an 
object that is specially drawn to give a 3D appearance in a 2D plane. Projection is a mathematical 
process used to display a 3D chart in a 2D plane. The following table describes the various types of 
projection. 

Projection Description

Oblique This is sometimes referred to as 2.5 dimensional. The chart has depth, but the XY plane 
does not change when the chart is rotated or elevated.

Orthogonal Perspective is not applied to the chart. The advantage of using this type of projection is 
that vertical lines remain vertical, making some charts easier to read.

Perspective This provides the most realistic 3D appearance. Objects farther away from you converge 
toward a vanishing point.

Viewing Distance. Enter a positive number that 
represents the distance from which the chart is viewed as a percentage of the depth of the chart.

The perspective of an object changes as you move closer to it or farther away from it. The same is true of 
a 3D chart. By default, 3D charts are viewed from a distance of 200 percent of the charts depth. 



Width To Height and Depth To Height. Enter a 
positive number in each of these fields to represent the percentage of the charts height used to draw the 
charts width and depth.



Format Plot 3D Lighting Tab
Formatting 3D Charts

The options on this tab control the amount and type of light used to illuminate a 3D chart.

Ambient Light. This type of light shines on all 
sides of chart elements and is cast in addition to light from fixed light sources. If ambient light is set to 100
percent, all sides of the chart elements are illuminated equally no matter what light sources you turn on. If 
ambient light is set to 0, only the sides of chart elements facing the active light sources are illuminated. 
The default setting for ambient light is 15 percent.

Use Edge Lights. Controls whether an edge 
pen is used on 3D objects. Check the box to turn edge lighting on. Uncheck the box to turn edge lighting 
off.

Edge Intensity. Enter a number between 0 and 
100 percent to specify the amount of lighting applied to the edges of 3D objects such as bars, lines, pies 
or doughnuts. An edge light intensity of 0 draws the edges as black lines. An edge light intensity of 100 



percent fully illuminates the edges using the edge pens color. The default edge pen color is the same as 
the series fill color. 

Light Source Intensities. You can "turn on" or 
"turn off" up to nine preset infinite light sources on your chart. An infinite light source means that while 
there is a direction towards which the light shines, there is not a fixed distance from which the light is 
shone. The position of the light source is at infinity with reference to the chart. This allows a more uniform 
illumination and shading of the chart surfaces. For each of the light sources, enter a value between 0 and 
100 percent. At an intensity of 100 percent, chart surfaces perpendicular to the light source are fully 
illuminated. At an intensity of 50 percent, these surfaces receive 50 percent illumination from this light. A 
setting of 0 turns off the light source.
Important       A chart surfaces total illumination is the sum of the contributions of the ambient light and 
each of the infinite lights. 



Format Plot Base and Walls Tab

The options on this tab control the appearance of the base and walls of 3D charts and the background 
behind the axis grid on 2D charts.

Base Height and Wall Width

Use these controls to specify the thickness of the base and the walls. These controls only affect 3D 
charts.

Base Height. Enter the number of points for the 
base height.

Wall Width. Enter the number of points for the 
wall width.

Base Fill and Wall Fill

Use these controls to specify the colors and patterns used to draw the base and walls of a chart. The 
Base Fill is not used for a 2D chart.



Pattern. Click the control to display the pattern 
picker. Select one of the patterns, click None to have no pattern on the object, or click Solid to use only 
the fill color to fill the object. 

Patterns are bitmaps. A low resolution version of each bitmap displays the pattern on the screen. When 
you print a chart, a high resolution version of the bitmap is used if the output device prints at more than 
144 dpi. The higher the resolution of the output device, the smaller the copies of the bitmaps that form the
patterns are reproduced. At high resolutions, First Impression adjusts the patterns to prevent the lines 
from getting too close together. Hatches are not bitmaps, but actual lines drawn to fill the object. They are 
always drawn at the same resolution, regardless of the output device. Hatches can be used to output First
Impression charts on a plotter. The last row of patterns in the pattern picker are hatch patterns.

Fill Color and Pattern Color. Click any of these
controls to display the Color Picker. Select one of the predefined colors or click Custom to mix your own 
color. 

Base Pen and Wall Pen

Use these controls to format the lines used to draw the base and wall edges. The Base Pen is not used 
on 2D charts.



Style. Select a line style for the lines that frame 
the walls or base.

Width. Select a width for the lines that frame the
walls or base; or, select Custom to specify your own line width.

Color. Click the control to display the Color 
Picker. Select one of the predefined colors to draw the lines that make up the base or walls; or, click 
Custom to mix your own color.



Format Series Dialog Box

This dialog box controls the appearance of individual series in the chart. If you use the menu to display 
this dialog box, you are prompted to identify the series you want to format. For information about the 
options on a specific tab of the Format Series dialog box, select the tab name from the following list.

Options

Fill

Line

Markers

Statistics

Guidelines



Format Series Options Tab

The options in the Options tab hide or exclude a series, plot the series on a secondary Y axis, change 
style of bars on a bar chart, set the gain and loss colors used in a hi-lo chart, and control smoothing for 
line and area series types.

Hide. Check this box to turn off display of the 
current series. The space occupied by the series is still shown on the chart, but the data is not displayed. 
Uncheck this box to redisplay a hidden series. In pie and doughnut charts, room is still reserved for 
hidden series pie slices, even though they are not displayed.

Exclude. Check this box to remove a series 
from a chart. The data is not displayed and the space occupied by the series is removed from the chart. 
Uncheck this box to return an excluded series to the chart. 

Plot On 2nd Y Axis. Check this box to plot the 
current series on the secondary Y axis instead of the primary axis. You may then want to change the 
scale, type, or format of the secondary axis to best display the series data. Uncheck this box to plot the 



data on the primary axis.

Bar Shapes

The options in this section of the tab control the appearance of bars in 3D bar charts; including horizontal 
bar charts, gantt charts, and clustered bar charts.

Sides. Enter a value between 3 and 360 to 
indicate the number of sides for the bars. Higher numbers of sides give the bars a rounder appearance.

Top Ratio. Enter a positive number to indicate 
the percent of the bottom diameter used to draw the top of the chart. Values less than 100 result in a top 
smaller than the bottom. Values greater than 100 result in the top wider than the bottom. 

Smoothing Series Data

The options in this section of the tab control the smoothing of series data. Smoothing is the process of 
using one of several mathematical formulas to divide the chart data into a number of facets. When the 
chart is drawn using these facets, the result is a smoother curve to the series lines. 

You can smooth line and area series types.



Function. Select a smoothing type from the 
popup menu. The following table describes the smoothing type.
Smoothing Type Description

None No smoothing is applied to the data.

QuadraticBSpline A quadratic B-spline formula determines the smoothing applied to the data. This 
form of smoothing results in a less-smooth curve that stays closer to the data 
points.

CubicBSpline A cubic B-spline formula determines the smoothing applied to the data. This form 
of smoothing results in a smoother curve, but varies further from the data point 
than a QuadraticB spline curve.

Factor. Specify the number of facets or points 
sampled between the chart data points to create the smoothing effect. The higher the number, the more 
smoothing occurs.

Hi-Lo-Close Colors

The controls in this section of the tab control the colors used to display the elements of a hi-lo chart.



Gain Color. Click the control to display the color
picker and select the color used to indicate a gain in value. Select a predefined color or click Custom to 
mix your own color. Select Automatic to have all elements that reflect a gain in value use the fill color 
defined for the series.

Loss Color. Click the control to display the color
picker and select the color used to indicate a loss in value. Select a predefined color or click Custom to 
mix your own color. Select Automatic to have all elements that reflect a loss in value use the fill color 
defined for the series.
Note     Gains and losses are calculated differently between open-hi-lo-close bar charts and other 
variations of hi-lo-close charts. A hi-lo-close chart calculates whether the close value for a point was a 
gain or a loss from the close point of the previous point. In other words, the first data point never has a 
gain or loss color, but sets the basis for deciding if the next data point displays a gain or loss. The open-
hi-lo-close bar chart calculates whether the close point was a gain or loss from the open value for the 
same point.



Fill Tab

The options in this tab control color, pattern, and edge pen used to display the series elements or 
individual data points. If the series is a 2D bar type, you can also specify a graphic image to use as the fill 
for the bars.

Setting Fill Color and Pattern

The options in the Fill section of the tab control the color and pattern used to display a chart element. 

Pattern. Click the control to display the pattern 
picker. Select the pattern or hatch you want to use to fill the chart element.

Patterns are bitmaps. A low resolution version of each bitmap is used to display the pattern on the screen.
When you print a chart, a high resolution version of the bitmap is used if the output device prints at more 
than 144 dpi. The higher the resolution of the output device, the smaller the copies of the bitmaps that 
make up the patterns are reproduced. At high resolutions, First Impression adjusts the patterns to prevent
the lines from getting too close together. Hatches are not bitmaps, but actual lines drawn to fill the object. 
They are always drawn at the same resolution, regardless of the output device. 

Fill Color. The fill color is used as the color for 
solid patterns. It is used as the background color for any other type of pattern. By default, the line color for
an element matches this fill color.



Pattern Color. The pattern color is used to draw
the pattern over the fill color if any pattern other than solid is selected. 

For both color controls, click the control to display the color picker. Select the color you want to use. You 
can choose Custom to display a color mixer and create your own color.

Setting Edge Color and Width

The edge pen outlines all 3D objects and all 2D elements except the lines in line, XY, hi-lo, radar, and 
polar charts.

Style. Click the control to display the line picker. 
The line picker displays the available line styles. Select the style you want to use to outline objects. 

Width. Click the control to display the available 
line widths. Select a width from the list or click Custom to specify your own width.



Color. Click the control to display the color 
picker. Select a predefined color, or select Automatic to have the outline drawn in the same color as the 
objects fill color. You can also click Custom to mix a new color.

Picture Bars

The controls in the picture section of the dialog box allow you to specify a graphic image to use as the fill 
for a series of 2D vertical or horizontal bars or gantt charts.

Picture. This control displays a preview of the 
graphic. When a valid path and file name are entered in the File text box, the picture is displayed in the 
Picture control. Only Windows Bitmap (.bmp) and Windows Metafiles (.wmf) are supported graphic 
formats.
Important     If you create picture bars using a Windows metafile, the pictures will not appear if you save 
the chart as a metafile. This is a Windows limitation that prevents a metafile from containing another 
metafile. If you plan to copy the chart to the clipboard, or save the chart as a metafile, use a bitmap for the
picture bars instead of a metafile.



Fit Method. You can choose how to fit the 
graphic into the bar. The following table lists the options for fitting graphics.
Method Description

Stacked Duplicates the graphic repeatedly to fill the bars. Since this uses multiple copies of 
the graphic, it is recommended that you use as small a file as possible.

Stretched To Fit Scales the graphic to fit the bars regardless of its original proportions.

File. Type the full path to the graphic file in the 
File field or press the Browse button to display an Open File dialog box. When you specify a valid path, a 
preview of the graphic appears in the Picture control.

Clear. Click this button to clear an existing 
picture from the picture control. 



Embed. Select the Embed check box to save 
the graphic with the file.

Paste. Click this button to place a .wmf or .bmp 
file from the clipboard into the current chart element. 
Note       You can also fill 2D bars with pictures interactively. Select the bar you want to fill on the chart. 
Click the right mouse button to display the floating menu and select Paste. Identify the graphic you want 
to paste into the bar and click OK.



Line Tab

The options on the Line tab format 2D lines and the lines in XY, radar, polar, and hi-lo charts.

Show Lines. Check this check box to display 
lines on a 2D chart. Uncheck this check box to hide the lines on the chart. 

The remaining controls in the dialog box control the style, width, color, joint, and end caps used to display 
lines.

Style. Click the control to select a style for the 
current line.

Width. Click the control to display the preset line
widths. Pick a width, or select Custom to assign your own width.



Color. Click the control to display the Color 
picker. Select one of the predefined colors, or click Custom to mix your own color.

Join. Select a method of joining line segments 
in the series. Join styles are particularly important when using thick lines. 
Join Types Description

Mitered The outer edges of the two lines are extended until they meet.

Round A circular arc is drawn around the point where the two lines meet.

Beveled The notch between the ends of two joining lines is filled.

Important     Very acute mitered joins are automatically beveled to avoid drawing large spikes along the 
line.

Caps. Select a type to specify how the ends of 
lines are displayed.
Cap Type Description



Butt The line is squared off at the endpoint.

Round A semicircle with a diameter of the line thickness is drawn at the end of the line.

Squared The line continues beyond the endpoint for a distance equal to half the line thickness and 
is squared off.



Markers Tab

The Markers tab controls the style, color, size, and line width used to display markers. Markers can be 
displayed on all chart types except pies and doughnuts.

Show Markers. Check this box to display 
markers on a series. Uncheck this box to remove markers from a series.

Automatic. Check this box to allow First 
Impression to use the next available marker to identify the series. Uncheck this box to select your own 
choice of marker.

The remaining options in this tab are enabled if you uncheck Automatic so that you can specify a marker 
style, color, size, and line width.

Style. Select a marker type to identify the data 
points in the current series. 



Color. Click the control to display the Color 
Picker. Select a color for the marker or click Custom and mix your own color.

Size. Enter the number of points for the marker 
diameter.

Pen Width. Select a width for the lines that form
the marker, or click Custom and set your own width.



Format Series Statistics Tab

The options in this tab specify the type of statistics lines that are displayed for the current series and the 
appearance of each line. Statistics lines are useful for analyzing data by showing information such as 
minimum value, maximum value, mean value, standard deviation, and regression trendlines. You can only
display statistics lines on 2D line and XY charts. 

Show check boxes. For each type of statistic, 
check the box to display the line or uncheck the box to remove the line. The following table describes 
each type of statistic.
Statistic Type Description

Minimum Shows the minimum Y value in the series.

Maximum Shows the maximum Y value in the series.

Mean Shows the mathematical mean of the Y values in the series.

Standard Deviation Shows the standard deviation of the Y values in the series.

Regression Shows a trend line indicated by the Y values in a series.

Line Styles. For each type of statistic, select a 
line style that uniquely identifies it.



Color. Select the color for the statistics lines that
represent the current series.

Width. Select a width for the statistics lines, or 
click custom and set a new width. 



Format Series Guidelines Tab

The    options on the Guidelines tab control    the display and format of guidelines for the series in 2D and 
3D line, area, and step chart as well as bubble charts. Guidelines are lines that are drawn from a data 
point to one or more axis to better identify the data point position.

Show Guidelines. Check this box to display 
guidelines for the series. Uncheck this box to remove guidelines.

The remaining controls in the dialog box control the appearance of the guidelines. You can specify a style,
width, color, and cap style for the guidelines. For specific information about each of these settings refer to 
the discussion of the Line tab. 



Format Series Label Dialog Box

This dialog box controls the display and appearance of series labels on area, step, and line charts.

For information about the options on a specific tab of the Format Series Label dialog box, select the tab 
name from the following list.

Options

Font

Text

Backdrop



Format Series Label Options Tab

The Options tab controls the display and position of the series label as well as the line style used to 
connect the label to the series.

Location. To display a series label on the chart, 
select one of the predefined positions. The following table describes the valid positions for series labels.
Positions Description

None Hides the label.

First The label is displayed above the first data point in the series.

Last The label is displayed above the last data point in the series.

Center The label is displayed above the middle data point in the series.

Label Line Style. To display a line connecting a 
label to a series it represents, select one of the Label Line Style radio buttons described in the following 
table.
Line Styles Description

None No line connects the label and series.

Line A straight line connects the label and series.

Angle Line An angled line connects the label and series.



Font Tab
See Also

A number of dialogs contain the font tab. Options on the font tab control the font, font style, size, color and
effects used to display text in a chart element.

Font. Select a font from the list of fonts installed 
on your Windows system.

Font Style. Select a style from the list of 
supported styles for the font you selected.

Size. Select a size from the list of valid sizes for 
the font you selected. You can also type a valid size in the Size field.



Effects. Check either or both the Strikeout and 
Underline check boxes to apply those effects to the text.

Sample. As you make selections from the other 
controls in this dialog box, the sample is updated to reflect the changes.

Color. Click the control to display the Color 
Picker. Select one of the predefined colors, or click Custom to mix your own color.



See Also

Format Axis Label Dialog Box

Format Axis Title Dialog Box

Format Data Point Label Dialog Box

Format Footnote Dialog Box

Format Legend Dialog Box

Format Series Label Dialog Box

Format Title Dialog Box



Text Tab
See Also

A number of dialog boxes contain the text tab. Options on the Text tab control the alignment and 
orientation used to display text. It also allows provides a place to enter or modify the text that makes up 
the chart element you are formatting.

Horizontal Alignment. The following table 
describes the horizontal alignment options for text. 
Alignment Description

Left All lines of text are aligned on the left margin.

Right All lines of text are aligned on the right margin.

Center All lines of text are centered horizontally.

Vertical Alignment. The following table 
describes the vertical alignment options for text.
Alignment Description

Top All lines of text are aligned at the top margin.

Bottom All lines of text are aligned at the bottom margin.

Center All lines of text are centered vertically.



Orientation. The following table describes the 
orientation options for text.
Orientation Description

Horizontal The text is displayed horizontally.

Vertical The text is displayed, one letter on top of each other, reading from top to bottom.

Up The text is rotated to read from bottom to top.

Down The text is rotated to read from top to bottom.

Note     When you rotate text up or down, the vertical and horizontal alignment are still relative to the text 
and not to the bounding box. In other words, text displayed with up orientation and left alignment is 
actually flush against the bottom of the bounding box, not the left side.

Word Wrap. Check this box to wrap any text 
that is too long to fit on one line of the bounding box. You can also insert line breaks manually by pressing
CTRL + ENTER anywhere in the text. This option is not available in the Format Data Point Label dialog 
box or the Format Series Label dialog box.



Text. Enter the text to be displayed by the chart 
element you are formatting.



See Also

Format Axis Label Dialog Box

Format Axis Title Dialog Box

Format Data Point Label Dialog Box

Format Footnote Dialog Box

Format Series Label Dialog Box

Format Title Dialog Box



Format Data Point Dialog Box

This dialog box is used to format the appearance of an individual data point. If you use the menu to 
display this dialog, you are prompted to identify which data point you want to format. 

For information about the options on a specific tab of the Format Data Point dialog box, select the tab 
name from the following list.

Options

Fill

Markers



Format Data Point Options Tab
See Also

The option on this tab controls whether or not the current data point uses the series display defaults.

Use Series Defaults Check box. Check this 
box to use the display formats assigned to the current series to display this data point. Uncheck this 
checkbox to enable the other tabs in this dialog box, allowing you to set specific fill, line or marker formats
for the current data point.



See Also

Fill Tab

Line Tab

Marker Tab



Format Data Point Label Dialog Box

This dialog box controls the text or value used to label a data point, as well as the font, format, position 
and backdrop used to display the label

For information about the options on a specific tab of the Format Data Point Label dialog box, select the 
tab name from the following list.

Options

Text

Font

Backdrop

Value Format

Percent Format



Format Data Point Label Options Tab

The Options tab controls the position of the data point label and the line style used to connect the label to 
the data point. 

Location. Select a location to display the label 
in relation to the data point. 
Locations Description

None No label displayed.

Above Point The label is displayed above the data point. This location is only valid for bar, line, area, 
step, XY, polar, radar, and bubble charts.

Below Point The label is displayed below the data point. This location is only valid for bar, line, area, 
step, XY, polar, radar, and bubble charts.

Center The label is displayed centered on the data point. This location is only valid for bar, line, 
area, and step charts.

Base The label is displayed along the category axis, directly beneath the data point. This 
location is only valid for bar, line, area, and step charts.

Inside The label is displayed inside a pie or doughnut slice.

Outside The label is displayed outside a pie or doughnut slice.

Left The label is displayed to the left of the data point. This location is only valid for XY, polar,
radar, and bubble charts.

Right The label is displayed to the right of the data point. This location is only valid for XY, 
polar, radar, and bubble charts.



Label Line Style. You can specify a line type 
that connects the label and the slice.
Line Styles Description

None No line connects the label and series.

Line A straight line connects the label and data point.

Angle line An angled line connects the label and data point.



Format Data Point Label Text Tab

The options on this Text tab to control the type of label displayed on the data point. 

You can use a data points value, value as a percent, data point name, or series name as a label. 
Alternatively, you can type in text for your own custom data point label.

Automatic. Select this radio button to have First
Impression automatically create a label for you. Check one or more of the label types described in the 
following table. If you select more than one type, the labels are stacked on top of each other..
Type Description

Value The value of the data point appears in the label.

Percent The value of the data point is displayed in the label as a percentage according to the 
axis percent basis.

Series Name The series name is used to label the data point. 

Data Point Name The category name is used to label the data point. 

Custom. Select this radio button to enter 
custom label text in the Text field. 



Text. Enter the custom label text in this field. 
Use CTRL + ENTER to force text to another line. 

Specific information about using the alignment and orientation options are discussed on the Text tab.



Format Data Point Label Value Format Tab

The options on this tab control the format mask used if the data point label is displayed as a value.

Category. Select a category to display a list of 
preset format strings appropriate for that type of data in the Format Code list box.

Format Code. Select one of the predefined 
strings. 

Custom. Enter valid format symbols in this field 
to create your own custom format. A complete discussion of the valid format symbols is presented in the 
discussion of the Axis Label Format Code Tab.



Format Data Point Label Percent Format Tab

The options on this tab control the format mask used if the data point label is displayed as a percent.

Category. Select a category to display a list of 
preset format strings appropriate for that type of data in the Format Code list box.

Format Code. Select one of the predefined 
strings. 

Custom. Enter valid format symbols in this field 
to create your own custom format. A complete discussion of the valid format symbols is presented in the 
discussion of the Axis Label Format Code Tab.



Format Axis Dialog Box

This dialog box controls the display of various axes, the scale of various types of axes, and the 
appearance of the axis grid and axis ticks. If you use the menu to display this dialog, you are prompted to 
specify which axis you want to format.

For information about the options on a specific tab of the Format Axis dialog box, select the tab name 
from the following list.

Options

Grid

Scale - Category Axis

Scale - Date Axis

Scale - Value Axis

Polar Axis

Radar Axis

Ticks



Format Axis Options Tab

The options on this tab control the line width and color of the axis line and tick marks.

Width. Select a predefined width from the list, or
click Custom to assign your own width.

Color. Click the control to display the Color 
Picker. Select a predefined color, or click Custom to mix your own color.



Format Axis Grid Tab

The options on the Grid tab control the color, line style, and line thickness used to display the major and 
minor grid lines on the chart. You may want to have different line widths, colors, or styles represent the 
major and minor grid to make it easier to tell them apart on the chart.

Width. Select a predefined width from the list or 
click Custom to design your own width.

Style. Select a line style from the list. 

Color. Click the control to display the Color 
Picker. Select a predefined color, or click Custom to mix your own color.



Format Axis Scale Tab - Category Axis
Axis Terminology

The options in the Scale tab control the display of the axis scale, the frequency of labels and ticks 
displayed on the axis, and the position in which the axis is drawn.

Show Scale. Check this box to display the axis 
scale, line, ticks, and title on the axis. Uncheck the box to hide the axis elements.

Automatic Scale. Check this box to let First 
Impression scale the axis based on the data being charted. Uncheck this box to manually scale the axis 
based on values you provide in the Divisions Per Label and Divisions per Tick options.

Divisions Per Label. A value of 1 labels every 
division. A value greater than 1 labels the first division and skips the labels for the extra divisions.



Divisions Per Tick. A value of 1 places a tick 
mark at every division. A value greater than 1 places a tick mark at the first division and skips the tick 
marks for the extra divisions.

Skipping labels and tick marks can help reduce the clutter of labels that can occur when you have a large 
number of divisions.

Labels on Tick Marks. Check this box to center
each label on a tick mark. Uncheck this box to center each label between two tick marks.

Axis Intersection 

Automatic. Check this box to have the axes 
intersect at their usual position. Uncheck this box to enable the Cross At and Labels Inside Plot options to 
specify where you want the current axis to intersect a perpendicular axis.



Cross At. Enter the position where you want the
current axis to cross its intersecting axis. If the intersecting axis is a value axis, enter the value where you 
want to place the current axis. If the intersecting axis is a date or category axis, enter the division number 
at which you want to place the current axis. 

Labels Inside Plot. Check this box to move the 
axis labels with the axis to the new intersection point. This may cause labels to display on top of the chart 
plot. Uncheck this box to leave the labels in their original position. Only the axis line and tick marks are 
drawn at the new intersection point.



Format Axis Scale Tab - Date Axis
Axis Terminology

The options in the Scale tab control the display of the axis scale, the axis values and intervals, and the 
position in which the axis is drawn.

Show Scale. Check this box to display the axis 
scale, line, ticks, and title on the axis. Uncheck the box to hide the axis elements.

Automatic Scale. Check this box to let First 
Impression scale the axis based on the minimum and maximum values in the data being charted. 
Uncheck this box to manually scale the axis based on values you provide.

If you uncheck the Automatic Scale check box, the following four options are enabled so that you can 
enter values to be used to scale the axis.

Minimum. Enter the lowest or beginning date for



the axis.

Maximum. Enter the highest or ending date for 
the axis scale.

Major Interval and Minor Interval. For each of 
these intervals, enter a number to specify how many intervals pass before a tick mark is placed on the 
axis. Then, select an interval type from the list box. 

The major ticks and grid lines appear at major intervals, and the minor ticks and grid lines appear at minor
intervals. Axis labels are drawn at major intervals. The following table describes the settings for these 
options.

Type Description

None No Interval.

Days A tick mark occurs each day.

Weeks A tick mark occurs Monday of each week.

Semi-months A tick mark occurs on the 1st and 15th day of each month.

Months A tick mark occurs on the 1st of each month.

Years A tick mark occurs on January 1 of each year.

For example, to create a quarterly scale, set the interval to 3 months.



Major Format. Select a date format to display 
the first level of axis labels.

You can add additional levels of labels to indicate month and year changes on the data axis. 

New Month. Select a format to be used to 
indicate a change of month. 

New Year. Select a format to be used to indicate
a change of year.
Note     First Impression displays dates in this tab using the Windows environment date format assigned 
though the Control Panel. A confusing situation can occur when using dates earlier than 1920. If you have
your date format set to not show centuries, the scale tab assumes the date displayed is between 1/1/1920
and 12/31/2019. So, if you have a date axis minimum of Jan 1, 1905, displayed as 1/1/05, the dialog will 
convert it to Jan 1, 2005. The solution is to use centruies in your Windows date format if you wat to deal 
with dates outside the range 1/1/1920 to 12/31/2019.

Axis Intersection 



Automatic. Check this box to have the axes 
intersect at their usual position. Uncheck this box to enable the Cross At and Labels Inside Plot options to 
specify where you want the current axis to cross an intersecting axis.

Cross At. Enter the position where you want the
current axis to cross an intersecting axis. If the intersecting axis is a value axis, enter the value where you
want to place the current axis. If the intersecting axis is a date or category axis, enter the division number 
at which you want to place the current axis. 

Labels Inside Plot. If you enter a value in the 
Axis Intersection option, this check box is enabled. Check this box to move the axis labels with the axis to 
the new intersection point. This may cause labels to display on top of the chart plot. Uncheck this box to 
leave the labels in their original position.



Skip Weekends. Check this box to not display 
dates that fall on weekends. Uncheck this box to display all dates regardless of day of the week.



Format Axis Scale Tab - Value Axis
Axis Terminology

The options in the Scale tab control the display of the axis scale, values and number of divisions on the 
axis, and the position in which the axis is drawn.

Show Scale. Check this box to display the axis 
scale, line, ticks, and title on the axis. Uncheck the box to hide the axis elements. 

Automatic Scale. Check this box to let First 
Impression scale the axis based on the minimum and maximum values in the data being charted. 
Uncheck this box to manually scale the axis based on values you provide

If you uncheck the Automatic Scale check box, the following four options are enabled so that you can 
enter values to be used to scale the axis.

Minimum. Enter the lowest or beginning value 



for the scale.

Maximum. Enter the highest or ending value for 
the scale.

Major Divisions. Enter the number of major 
divisions you want on the axis. Axis labels are only displayed on major divisions.

Minor Divisions. Enter the number of minor 
divisions you want between each major division of the axis.



Type. Select the type of scale you want to use 
on the axis. The following table describes the types of axis scaling
Type Description

Linear Data points are plotted in a linear scale with values ranging from the minimum to the 
maximum chart value. This is the default scale type.

Logarithmic Data points are plotted in a logarithmic scale with values based on a specific log scale. 
Logarithmic axes are not appropriate for zero or negative data.

Percent Data points are plotted in a linear scale as percentages of the chart values. Changing the 
percent basis of a chart is useful for determining overall trends in data rather than specific 
values.

Log Base. Enter the logarithm base to be used 
for a logarithmic scale axis. The default base is 10.



Percent Basis. If you select Percent as the axis 
type, you can choose one of the following methods of calculating the percentages.
Constant Description

Chart Maximum The largest value in the chart is considered 100 percent and all other values on 
the chart are displayed as percentages of that value.

Category Maximum The largest value in each category is considered 100 percent and all other values 
in that category are displayed as percentages of that value.

Series Maximum The largest value in each series is considered 100 percent and all other values in 
that series are displayed as percentages of that value.

Chart Total All values in the chart are added together, and that value is considered 100 
percent. All values in the chart are displayed as percentages of that value.

Category Total All values in each category are added together to give a total value for each 
category. All values are displayed as a percentage of their category total. 

Series Total All values in each series are added together to give a total value for each series. 
All values are displayed as a percentage of their series total. 

Axis Intersection 

Automatic. Check this box to have the axes 
intersect at their usual position. Uncheck this box to enable the Cross At and Labels Inside Plot options to 
specify where you want the current axis to cross the intersecting axis.



Cross At. Enter the position where you want the
current axis to cross an intersecting axis. If the intersecting axis is a value axis, enter the value where you
want to place the current axis. If the intersecting axis is a date or category axis, enter the division number 
at which you want to place the current axis. 

Labels Inside Plot. Check this box to move the 
axis labels with the axis to the new intersection point. This may cause labels to display on top of the chart 
plot. Uncheck this box to leave the labels in their original position. Only the axis line and tick marks are 
drawn at the new intersection point.



Format Axis Scaling Tab - Radar Axis 
Axis Terminology

The only scaling change you can make for a radar axis is to turn the display of the axis on or off. 
Unchecking the Show Scale check box turns off the category labels at the end of each value axis. The 
value axes on a radar chart can be formatted like any other value axis.



Format Axis Scaling Tab -Polar Axis 
Axis Terminology

The radius axis on a polar chart can be formatted just like any other value axis. Scaling the polar axis 
allows you to control the number of radial grid lines and labels that are displayed around the perimeter of 
the chart. The Scale tab provides the following options for the polar axis.

Automatic Scale. Check this box to let First 
Impression scale the axis based on the data being charted. Uncheck this box to manually scale the axis 
based on values you provide. 

If you uncheck the Automatic Scale check box, the following four options are enabled so that you can 
enter values to be used to scale the axis.

Major Divisions. Enter the number of major 
divisions you want on the axis. Radial grid lines for major divisions extend to the center of the chart.



Minor Divisions. Enter the number of minor 
divisions you want between each major division of the axis. Radial grid lines for minor divisions extend 
from the first division of the value axis to the perimeter of the chart.

Axis labels are drawn at both major and minor divisions.



Format Axis Ticks

The options on this tab control the appearance of axis ticks.

Length. Enter the length of the major tick marks 
in points. Minor tick marks are drawn at half this length.

Location. Select a style from the list box to 
specify the position of the tick on the axis. The following table describes available settings.
Style Description

None No tick marks are displayed on the axis. 

Center Tick marks are centered across the axis.

Inside Tick marks are displayed inside the axis.

Outside Tick marks are displayed outside the axis.



Format Axis Label Dialog Box
Formatting Axis Labels 

This dialog box controls the position of axis labels, and the backdrop, font, and format used to display 
them. f you use the menu to display this dialog, you are prompted to specify which axis you want to 
format.

For information about the options on a specific tab of the Format Axis Labels dialog box, select the tab 
name from the following list.

Backdrop

Text 

Font

Format Code



Format Axis Labels Text Tab

The options in the Text tab of the Format Axis Label dialog box control the alignment and orientation used 
to display the axis labels.

Automatic. Check this box to allow First 
Impression to rotate the labels if necessary to optimize the chart layout. Uncheck this box to set a specific
horizontal and vertical alignment and orientation for the label text.

The Horizontal, Vertical, and Orientation sections of the dialog box are enabled if you uncheck the 
Automatic check box. The horizontal and vertical alignment refer to how the text is aligned within each 
division.

Horizontal Alignment. The following table 
describes the horizontal alignment options for label text. 
Alignment Description

Left Each label is aligned at the left edge of the division.

Right Each label is aligned at the right edge of the division.

Center Each label is centered horizontally within the division.

 



Vertical Alignment. The following table describes 
the vertical alignment options for label text.
Alignment Description

Top Each label is aligned at the top of the division.

Bottom Each label is aligned at the bottom of the division.

Center Each label is centered vertically within the division.

Orientation. The following table describes the 
orientation options for label text.
Orientation Description

Horizontal The text is displayed horizontally along the direction of the axis.

Vertical The text is displayed, one letter stacked on top of each other, reading from top to bottom.

Up The text is rotated so its right edge is next to the axis.

Down The text is rotated so its left edge is next to the axis.

Note     When you rotate text up or down, the vertical and horizontal alignment are still relative to the text 
and not to the chart. In other words, text displayed with up orientation and right alignment is actually flush 
against the axis, not the left side of the division.



Standing. On 3D charts, check this box to rotate
labels up on the text baseline to stand in the Y plane. Standing text can make the labels more legible if 
you are viewing the chart at very low elevations. This option applies only to labels on an X or Z axis on 
most charts, and the Y axis on horizontal charts.. Uncheck this box to return labels to their standard 
position in the X or Z plane.



Format Axis Labels Format Code Tab

The options in the Format Code tab specify the mask used to display the label value or text.

Category. Select a category to display a list of 
preset format strings appropriate for the type of label in the Format Codes list box.

Format Code. Select one of the predefined 
strings. The following table lists the built-in number formats and the results if the format is applied to a 
positive, negative, and decimal number. 
Category Format 3 -3 .3

All General 3 -3 .3

Fixed 0 3 -3 0

0.00 3.00 -3.00 0.30

#,##0 3 -3 0

#,##0.00 3.00 -3.00 0.30

#,##0_);(#,##0) 3 (3) 0

#,##0_);[RED](#,##0) 3 (3) in red 0

#,##0.00_);(#,##0.00) 3.00 (3.00) 0.30

#,##0.00_);[RED](#,##0.00) 3.00 (3.00) in red 0.30



Currency $#,##0_);($#,##0) $3 ($3) $0

$#,##0_);[RED]($#,##0) $3 ($3) in red $0

$#,##0.00_);($#,##0.00) $3.00 ($3.00) $0.30

$#,##0.00_);[RED]$
(#,##0.00)$3.00

($3.00) in 
red

$0.30

Percentage 0% 300% -300% 30%

0.0% 300.0% -300.0% 30.0%

0.00% 300.00% -300.00% 30.00%

Fraction # ?/? 3 -3 2/7

# ??/?? 3 -3 3/10

Scientific 0.00E+00 3.00E+00 -3.00E+00 3.00E-01

##0.0E+0 3.0E+0 -3.0E+0 3.0E-01

The following table lists the built-in date and time formats and the result of applying the format.

Category Format Result

Date m/d/y 2/3/94

d-mmm-yy 3-Feb-94

d-mmm 3-Feb

mmm-yy Feb 94

m/d/y h:mm 2/3/94 6:15

Time h:mm AM/PM 3:29 PM

h:mm:ss AM/PM 3:29:41 PM

h:mm 15:29

h:mm:ss 15:29:41

mm:ss 29:41

[h]:mm:ss 29:09:33



Custom. Enter valid format symbols in this field 
to create your own custom format. You can also create a custom format. The following table lists the 
format symbols that can be used in a custom format string.
Format Symbol Description

General Displays the number in General format.

0 Digit placeholder. If the number contains fewer digits than the format contains 
placeholders, the number is padded with 0's. If there are more digits to the right of 
the decimal than there are placeholders, the decimal portion is rounded to the 
number of places specified by the placeholders. If there are more digits to the left of 
the decimal than there are placeholders, the extra digits are retained.

# Digit placeholder. This placeholder functions the same as the 0 placeholder except 
the number is not padded with 0's if the number contains fewer digits than the format
contains placeholders.

? Digit placeholder. This placeholder functions the same as the 0 placeholder except 
that spaces are used to pad the digits.

. (period) Decimal point. Determines how many digits (0's or #'s) are displayed on either side 
of the decimal point. If the format contains only #'s left of the decimal point, numbers
less than 1 begin with a decimal point. If the format contains 0s left of the decimal 
point, numbers less than 1 begin with a 0 left of the decimal point.

% Displays the number as a percentage. The number is multiplied by 100 and the % 
character is appended.

, (comma) Thousands separator. If the format contains commas separated by #'s or 0's, the 
number is displayed with commas separating thousands. A comma following a 
placeholder scales the number by a thousand. For example, the format 0, scales the
number by 1000 (e.g., 10,000 would be displayed as 10).

E- E+ e- e+ Displays the number as scientific notation. If the format contains a scientific notation 
symbol to the left of a 0 or # placeholder, the number is displayed in scientific 
notation and an E or an e is added. The number of 0 and # placeholders to the right 
of the decimal determines the number of digits in the exponent. E- and e- place a 
minus sign by negative exponents. E+ and e+ place a minus sign by negative 
exponents and a plus sign by positive exponents.



$ - + / ( ) : space Displays that character. To display a character other than those listed, precede the 
character with a back slash (\) or enclose the character in double quotation marks (" 
"). You can also use the slash (/) for fraction formats.

\ Displays the next character. The backslash is not displayed. You can also display a 
character or string of characters by surrounding the characters with double quotation
marks (" ").

* (asterisk) Repeats the next character until the width of the column is filled. You cannot have 
more than one asterisk in each format section.

_ (underline) Skips the width of the next character. For example, to make negative numbers 
surrounded by parentheses align with positive numbers, you can include the format 
_) for positive numbers to skip the width of a parenthesis.

"text" Displays the text inside the quotation marks.

@ Text placeholder. Text replaces the @ format character.

m Month number. Displays the month as digits without leading zeros (e.g., 1-12). Can 
also represent minutes when used with h or hh formats.

mm Month number. Displays the month as digits with leading zeros (e.g., 01-12). Can 
also represent minutes when used with the h or hh formats.

mmm Month abbreviation. Displays the month as an abbreviation (e.g., Jan-Dec).

mmmm Month name. Displays the month as a full name (e.g., January-December).

d Day number. Displays the day as digits with no leading zero (e.g., 1-9).

dd Day number. Displays the day as digits with leading zeros (e.g., 01-31).

ddd Day abbreviation. Displays the day as an abbreviation (e.g., Sun-Sat).

dddd Day name. Displays the day as a full name (e.g., Sunday-Saturday).

yy Year number. Displays the year as a two-digit number (e.g., 00-99).

yyyy Year number. Displays the year as a four-digit number (e.g., 1900-2078).

h Hour number. Displays the hour as a number without leading zeros (1-23). If the 
format contains one of the AM or PM formats, the hour is based on a 12-hour clock. 
Otherwise, it is based on a 24-hour clock.

hh Hour number. Displays the hour as a number with leading zeros (01-23). If the 
format contains one of the AM or PM formats, the hour is based on a 12-hour clock. 
Otherwise, it is based on a 24-hour clock.

m Minute number. Displays the minute as a number without leading zeros (0-59). The 
m format must appear immediately after the h or hh symbol. Otherwise, it is 
interpreted as a month number.



mm Minute number. Displays the minute as a number with leading zeros (00-59). The 
mm format must appear immediately after the h or hh symbol. Otherwise, it is 
interpreted as a month number.

s Second number. Displays the second as a number without leading zeros (0-59).

ss Second number. Displays the second as a number with leading zeros (00-59).

AM/PM

am/pm

A/P

a/p 12-hour time. Displays time using a 12-hour clock. Displays AM, am, A, or a for 
times between midnight and noon; displays PM, pm, P, or p for times from noon until
midnight.

[BLACK] Displays text in black.

[BLUE] Displays text in blue.

[CYAN] Displays text in cyan.

[GREEN] Displays text in green.

[MAGENTA] Displays text in magenta.

[RED] Displays text in red.

[WHITE] Displays text in white.

[YELLOW] Displays text in yellow.

[COLOR n] Displays text using the corresponding color in the color palette. n is an index to a 
color in the color palette.



Format Axis Title Dialog Box
Formatting Axis Titles 

This dialog box controls the text used as a title for the axis chart. It also controls the font and backdrop 
used to display the title. If you use the menu to display this dialog, you are prompted to specify which axis
you want to format.

For information about the options on a specific tab of the Format Axis Title Dialog Box select the tab name
from the following list.

Text

Backdrop

Font



Format Legend Dialog Box

This dialog box controls the positioning and appearance of the chart legend.

For information about the options on a specific tab of the Format Legend dialog box, select the tab name 
from the following list.

Backdrop

Font

Location



Format Title Dialog Box

This dialog box controls the positioning and appearance of the chart title.

For information about the options on a specific tab of the Format Title dialog box, select the tab name 
from the following list.

Backdrop

Text

Font

Location



Format Footnote Dialog Box

This dialog box controls the positioning and appearance of the chart footnote.

For information about the options on a specific tab of the Format Footnote dialog box, select the tab name
from the following list.

Backdrop

Text

Font

Location



Print Dialog Box

This dialog box controls the appearance of the chart when it is printed. For more information about the 
options on a specific tab of the    Print dialog box, select the tab name from the following list.

Print 

Page Setup

Print Setup



Print Tab

The options on this tab control the number of copies and layout of the chart you are printing.

Layout. Select Use Screen Layout to print the 
chart exactly as it appears on the screen. Select Layout for Printer to layout the chart to best fit the page. 
Chart elements such as axis labels and data points are repositioned as they would be if you had resized 
the chart on the screen..

Copies. Enter the number of copies of the chart 
you want printed.



Page Setup Tab
Printing Charts

You can use the options on the Page Setup tab to change page margins and control how the chart is 
positioned on the page. 

Size. Select Actual Size to print the chart at the 
original size it was created. Select Best Fit to scale the chart proportionally to fit the page. Select Stretch 
to Fit to scale an image of the chart to fit the page, regardless of its original proportions.

Center. Check Center Horizontally to center the 
chart horizontally on the page. Uncheck Center Horizontally to print the chart at the left margin of the 
page. Check Center Vertically to center the chart vertically on the page. Uncheck Center Vertically to print
the chart at the top margin of the page.

Margins. Enter a value in inches or centimeters,
depending on your Windows settings to specify the top, bottom, left, and right margins of the page. 





Print Setup Tab

The Print Setup tab provides standard Windows settings for selecting the printer, page orientation, and 
paper size and source.



Dialog Box Help

Format Chart Dialog Box

Format Plot Dialog Box

Format Series Dialog Box

Format Series Label Dialog Box

Format Data Point Dialog Box

Format Data Point Label Dialog Box

Format Axis Dialog Box

Format Axis Labels Dialog Box

Format Axis Title Dialog Box

Format Legend Dialog Box

Format Title Dialog Box

Format Footnote Dialog Box

Print Dialog Box

 



Changing the 3D View
3D View Tab

You can change the rotation, elevation, viewing distance, and proportions of a 3D chart using settings on 
the 3D View tab of the Format Plot dialog box. You can also change the rotation and elevation of a chart 
interactively.

To change the rotation and elevation of a chart interactively:

1. Place the pointer anywhere in the chart region.

2. Press and hold the CTRL key.

The cursor changes to the rotation cursor.

3. Click and hold the left mouse button.

A dotted bounding box appears around the chart plot. Reference arrows appear at the corner 
where the first data point in the first series is drawn.

4. Move the pointer up and down to change the chart elevation and right and left to change the chart
rotation.

The bounding box shows the position of the chart plot as you move the mouse.

5. When you find the rotation and elevation you want, release the mouse button.

The chart repaints in the new position.

To change the 3D view:

1. Double click the chart plot; or, click the right mouse to display the floating menu and select Plot.

2. Click the 3D View tab.

3. Make any necessary changes and click OK or Apply to redraw the chart reflecting the changes.



Formatting the Base and Walls
Base and Walls Tab

You can change the colors and patterns applied to the walls of a 2D chart and the walls and base of a 3D 
chart, the color used to draw the lines in the base and walls, the height of the base and the width of the 
walls. The width of the walls and height of the base are measured in points. 

To format the walls and base:

1. Double click in the chart plot; or, use the right mouse button to display the floating menu and 
select Plot. 

2. Select the Base and Walls tab.

3. Make any necessary changes and click OK or Apply to redraw the chart to reflect the changes.



Lighting 3D Charts
3D Lighting Tab

When light falls on a 3D object some areas of the object are brightly illuminated, and other areas are in 
shadows. You have complete control of how much light strikes the chart, and from what direction. 

To change the lighting on a 3D chart:

1. Double click the chart plot; or, click the right mouse button to display the floating menu and select 
Plot.

2. Select the 3D Lighting tab.

3. Make any necessary changes and click OK or Apply to redraw the chart to reflect the changes.
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Axis Terminology

There are three types of axes that can appear on a chart: a value axis, a category axis, and a date axis. 
Category axes have text labels identifying the category or series in the chart. Value axes display numbers
as values or percents. Date axes display a range of dates. The following table provides a list of the types 
of each axis on various chart types.

Chart Type X Y 2nd Y Z

2D Bar

2D Line

2D Area

2D Step

2D Combination

Category Value Value N/A

3D Bar

3D Line

3D Area

3D Step

3D Combination

Category Value Value Category

2D and 3D Horizontal Bar Category Value N/A N/A

2D and 3D Gantt Category Date N/A N/A

XY Value Value N/A N/A

Bubble Value Value N/A N/A

Hi-Lo Date or 
Category

Value Value N/A

Polar Angle Value N/A N/A

Radar Radar Value N/A N/A

Formatting an Axis
Format Axis Dialog Box

The following discussion provides information for formatting all types of axes.

To format an axis:

1. Double click the axis or use the right mouse button to display the floating menu and select 
Axis/Axis.

If you use the menu, you must specify which axis you want to format. The Format Axis dialog box is 
displayed.



2. Make any necessary changes to any axis options and click OK or Apply to redraw the chart. 
Specific information about the options on each tab are presented in the following material.



Formatting Axis Labels
Format Axis Labels Dialog Box

You can change the font, font size, orientation, and alignment of axis label text, use a mask to format the 
text, and create a backdrop for the label. Labels on individual pie charts are actually x axis labels. To 
format pie chart labels, format the x axis labels on a chart.

To format a set of axis labels:

1. Double click on one of the labels you want to format; or select Axis/Labels to display the Format 
Axis Labels dialog box.

If you use the menu you are prompted to specify which axis and level of labels you want to format.

The following table describes each of the tabs on the Format Axis Labels dialog box

Tab Description

Backdrop Controls the fill, frame, and shadow used to create a backdrop for the axis label. 

Text Controls the orientation and alignment of the axis labels.

Font Controls the font, font size, font color, font style, and special effects used to display the axis
label text. 

Format Code Controls the mask used to display the axis labels.



Axis Titles
Format Axis Title Dialog Box

You can add a title for each axis. Axis titles can provide additional information about the axis that helps 
the viewer interpret the chart.

To create an axis title:

1. Use the right mouse button to display the floating menu.

2. Select Axis/Title to display the Format Axis Title dialog box.

3. Check the Visible check box to display the title.

4. Type the title text in the Text field.

5. Click OK or Apply to redraw the chart to include the new title.

The following table describes each of the tabs on the Format Axis Labels dialog box

Tab Description

Text Controls the text used for the axis title as well as the orientation and alignment of the text.

Backdrop Controls the fill, frame, and shadow used to create a backdrop for the axis title. 

Font Controls the font, font size, font color, font style, and special effects used to display the axis
title. 
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Formatting Series
Format Series Dialog Box 

To format a chart series:

1. Double click the series in the chart or the legend key that identifies the series.

The Format Series dialog box is displayed.

Alternatively, you can use the right mouse button to display the floating menu and select Series/Series 
from the menu. Then, select the series you want to format from the Select Data Series dialog box and 
click Select.

The Format Series dialog box appears with either the Fill or Line tab selected. 

2. When you have made all the formatting changes required for the series, click OK or Apply to 
redraw the chart to reflect the changes you have made.



Formatting Data Points
Format Data Point Dialog Box

By default, each data point in a series has the same format. However, there may be times that you want 
to highlight one or more data points in a series by changing their format. 

To format an individual data point:

1. Click a data point to select its series. 

2. Click the data point again to select just the data point. 

3. Double-click the data point to display the Format Data Point dialog box.

Alternatively, you can click the right mouse button to display the floating menu and select Series/Data 
Point. A dialog box appears asking you to specify the series and data point you want to format. You can 
pick Series Defaults to format the default fill and markers for the entire series.

The Options tab of the Format Data Point dialog box is displayed. 

4. Uncheck the Use Series Defaults check box to ungray the Fill and Markers tabs. You can then 
change any of the Fill or Marker options used to display the data point. Check the Use Series 
Defaults check box to discard any custom settings you have made for the data point and reset all 
options to the series defaults.

5. Click the Fill tab to modify the fill options for the data point. 

6. Click the Marker tab to modify the marker options for the data point. 
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Series Labels
Format Series Labels Dialog Box

Series labels can be used instead of the legend, as a way to identify each series on a line, area, step, XY,
or radar chart.

To format a series label:

1. If a series label exists, double click it. Otherwise, use the right mouse button to display the 
floating menu and select Series/Label.

2. Specify the series for which you want to define a label and click Select to display the Format 
Series Label dialog box.

3. Make any other changes to the series labels. Then, click OK or Apply to redraw the chart to 
reflect the changes.

You can reposition series labels by selecting them with the mouse and dragging them to new locations. 



Data Point Labels
Format Data Point Labels Dialog Box

You can format data point labels for all the data points in a series or for an individual data point. Data 
point labels can provide additional information about, or draw attention to, a data point.

To format data point labels:

1. Double-click the existing data point label to display the Format Data Point Label dialog box.

Alternatively, you can click the right mouse button to display the floating menu and select Series/Data 
Point Label. A dialog box appears asking you to specify the series and data point you want to format. You 
can pick Series Defaults to format the data point labels for every data point in the series.

2. Uncheck the Use Series Defaults check box to enable other tabs in the dialog box. You can then 
change any of the options used to display the data point. Check the Use Series Defaults check 
box to discard any custom settings you have made for the data point label and reset all options to
the series defaults.

3. Make any necessary changes to the tabs in the Format Data Point dialog box and click OK or 
Apply to redraw the chart to reflect the changes.

You can reposition data point labels by selecting them with the mouse and dragging them to a new 
location. 
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Exporting Charts

There are two ways to export copies of a chart from First Impression: by saving it to a file, or by copying it 
to the clipboard. 

To copy a chart to the clipboard:

1. Use the right mouse button to display the floating menu bar and select Copy. 

A copy of the current chart is placed on the clipboard in Windows Metafile format. You can then view the 
chart in any application that supports the .wmf format.

To save the chart to a file:

1. Use the right mouse button to display the floating menu bar and select Save As.

The Save As dialog box appears. 

2. Enter a name and path for the file.

3. Select a file type from the Save File As Type popup. 

You can save the chart in the native First Impression format (.vtc), as a metafile (.wmf) or as a Windows 
bitmap (.bmp). The metafile with size information includes the Adobe placeable header information in the 
metafile.

4.  Check Save metafile without size if you do not want the Adobe placeable header information in 
the metafile. 

You should not check this option if you will be using this metafile in a Microsoft application such as Word 
or Excel. These applications expect the size information to be there.

5. Check Save Text As Curves if you are using an unusual font that may not be present on other 
systems that will be using the metafile. 

This option should also be used to properly display text if you are deforming the metafile by stretching it.



Loading Saved Charts

You can load a chart that was saved in First Impressions native format into the current chart control. Any 
chart that currently exists in the control is discarded.

To load a file:

1. Use the right mouse button to display the floating menu bar and select Load.

The Load Chart dialog box appears. A list of all .vtc files in the current directory is displayed.

2. Select the file you want to load.

3. Click OK. 



Printing Charts

Print Dialog Box

You can print a copy of the current chart.

To print a chart:

1. Use the right mouse button to display the floating menu bar and select Print to display the Print 
dialog box.

2. Make any necessary settings and click Print.
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